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License & Copyright 

Maxsurf Program  

© 1985-2009 Formation Design Systems 

Maxsurf is copyrighted and all rights are reserved. The license for use is granted 

to the purchaser by Formation Design Systems as a single user license and does 

not permit the program to be used on more than one machine at one time. 

Copying of the program to other media is permitted for back-up purposes as long 

as all copies remain in the possession of the purchaser. 

 

Maxsurf Training Manual  

© 1990-2009 Formation Design Systems 

All rights reserved. No part of this publication may be reproduced, transmitted, 

transcribed, stored in a retrieval system, or translated into any language in any 

form or by any means, without the written permission of Formation Design 

Systems. Formation Design Systems reserves the right to revise this publication 

from time to time and to make changes to the contents without obligation to 

notify any person or organization of such changes. 

 

DISCLAIMER OF WARRANTY 

Neither Formation Design Systems, nor the author of this program and 

documentation are liable or responsible to the purchaser or user for loss or 

damage caused, or alleged to be caused, directly or indirectly by the software and 

its attendant documentation, including (but not limited to) interruption on 

service, loss of business, or anticipatory profits. No Formation Design Systems 

distributor, or agent, or employee is authorized to make any modification, 

extension, or addition to this warrant 
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Learning Maxsurf 

Welcome to Learning Maxsurf. This introductory training manual will give new 

users to Maxsurf a thorough understanding of the applicationôs architecture, 

main functions and give an idea of its capabilities. Experienced users will also 

find this manual useful to expand their understanding of concepts or simply as a 

refresher. 

 

This training manual is by no means an extensive guide to using Maxsurf. If you 

need help or would like more information on certain topics, the manual should 

be consulted. The training manual consists of several short tutorials, each with 

their own concrete learning goal. Throughout the tutorials, the user will model a 

simple hullshape and make modifications to it. Each tutorial may have different 

related resources such as: 

1. Sample designs. Some tutorials will have a ñstartò and ñendò sample 

design attached to it. For example: BasicFairing_start.msd and 

BasicFairing_end.msd. All these designs can be found in the c:\program 

files\Maxsurf\Training Samples directory. 

2. Explanations of background theory. It is recommended to read these 

sections. 

3.  Videos. There are several short videos you can watch that illustrate 

the steps explained in the tutorial.  

a. [Web] You can click on this link for each video to view the 

video online; i.e. on the internet. This will open up the video in 

your Internet browser. You do need a reasonably fast internet 

connection for this. 

b. [Disk] Click on this link from your PDF document when you are 

running this training manual from your local computer. This will 

start up the video from your local hard drive. This is generally 

much faster than viewing the videos online, but it does require 

that you have installed the MSLearning installer. Links to 

ñ[Disk]ò only work from the PDF document and not from your 

internet browser. 

4. Links to the User Manual for background reading on concepts, or further 

explanation of dialogs and related commands. 

 

Tips on using this training material: 

 Take you r time and read all instructions carefully  

 Read explanations, try to understand the concepts explained  

 

 

Start the training by reading ñChapter 1 Maxsurf Helpò.

http://www.fdsfiles.com/training/learningmaxsurf/MSLearning.exe
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Chapter 1 Maxsurf Help 

Before you can start learning how to use the program, it is important that you 

learn what to do when you want more information on using particular commands 

or you need help with a particular feature. Every command in the Maxsurf 

applications is thoroughly documented in the User Manual. This section of the 

training manual describes how to open the manual and find what you are looking 

for. 

Opening the Manual 

You can access the manual from different locations: 

1. From the Windows Start Menu: Programs | Maxsurf | Help 

2. From within the application in the Help menu 

3. From within the application by pressing the F1 function key.  

Note 

In this Training Manual, a vertical bar ó|ô will be used to separate 

menu titles, sub-menu titles and commands in specifying the 

location of a command from a menu. For example, Help | Maxsurf 

Help indicates that Maxsurf Help can be accessed from the Help 

Menu. 

 

Many commands can be accessed from toolbars and via keyboard 

shortcuts (specified in the menus); however in this manual, access 

to commands will be described through navigation of the menus.  

You will need Adobe PDF reader to open the manuals. 

Finding a Topic 

If you have opened the Maxsurf User Manual PDF file, you can search for a key 

word or phrase by clicking on Search from the Edit menu, and following the 

instructions in the Search PDF pane. 

 

You can also use this toolbar button:  or Ctrl+Shft+F .  

Other Resources 

The manual is also available in Adobe Acrobat (PDF) format from the Formation 

Design Systems Support Centre at www.formsys.com/support.  

 

The Support Centre also offers a Knowledgebase which includes Frequently 

Asked Questions and Tips and Tricks databases. 

 

Continue with the Chapter 2 Starting Maxsurf section on the next page.

http://www.adobe.com/
http://www.formsys.com/support
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Chapter 2 Starting Maxsurf 

If you have not already done so,  

ü Install Maxsurf by inserting the CD and running the Setup 

program, and then follow the instructions on screen. 

ü Launch the Maxsurf application on your computer from the strart 

menu.  

You should see something like this:  

 

If you see something completely different:  

ü Close the application and start it again, this time while holding 

down the Shift key.  

This will bring up the following dialog:  

 

ü Clear all Maxsurf Preferences 

Before you can do anything in the application, you either have to start a new 

design or open an existing design. 
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Continue reading the Opening a Design section. 

Opening a Design 

Opening a Design - Concepts 

A Maxsurf file has a .msd file extension and can be recognised by the  file 

icon. As in most Microsoft Windows applications, you can open files in different 

ways. For example, you can open files by double clicking on them or by using a 

File | Open menu. Letôs have a look at the different ways you can open a file in 

Maxsurf. 

Opening a Design ï Video 

 Watch a short video that shows you how to open a design in Maxsurf using 

the File | Open method and the drag and drop method. [Web | Disk] 

Opening a Design ï Procedures - File | Open  

File | Open 

Probably one of the most conventional ways to open a file is by: 

ü Start the Maxsurf application 

ü Click File | Open Design 

ü Navigate to the Maxsurf program file directory . 

This is C:\Program Files\Maxsurf, unless you have specified it differently. 

ü Open the Sample Designs folder 

 

ü Select the design called Maxsurf Sample_Trawler.msd and open 

it. 

Done! The design will initially be displayed in each of the four view windows by 

the outline of its surface edges (in the case of the Sample Trawler, there is only 

one surface), represented as solid grey lines. 

 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/opening-a-design#-6AJ-RR6UrmSYZ7mGOTegA
TrainingVideos/OpeningDesignP.avi
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Note 

All Maxsurf applications have the ability to open different sets of 

data. For example in Maxsurf you can load Markers or surface 

models. The type of data that can be opened is determined by the 

Window that you have currently got ñactiveò or ñfrontmostò. You 

will learn about the different Maxsurf Windows later. 

Opening a Design ï Procedures - Double Click 

Double Clicking on a File 

ü In Windows explorer, navigate to  

c:\program files\Maxsurf \Sample Designs 

ü Double click on the file called Maxsurf Sample_Trawler.msd 

This will start up a new Maxsurf application and bring up the following dialog 

first: 

 

ü You can select the Workshop Library.wsl or hit Escape to skip 

this step. 

The Workshop Library is only used in case you wish to allocate material 

properties (eg. material and thickness) to a surface in Maxsurf and will not be 

needed during the LearningMaxsurf training. 

Opening a Design ï Procedures ï Drag and Drop 

Drag and Drop 

One of the less known options is that you can actually drag a .msd file onto any 

of the View windows of the Maxsurf application.  

ü Close all applications you may have open on your computer, so 

that you donôt get confused with the next few steps. 

ü Start Maxsurf  

ü In Windows explorer, navigate to  

c:\program files\Maxsurf \Sample Designs 
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ü Hold down the left mouse button after clicking on the Maxsurf 

Sample_Trawler.msd once. 

ü Now drag and drop the file into any of the View windows in 

Maxsurf:  

 

Dragging and dropping the file from Windows explorer window into one of Maxsurfôs View windows. 

 

Continue with the section on Closing a Maxsurf Design. 

Closing a Maxsurf Design 

You can close a design from the File menu:  

ü File | Close Design 

In case there have been any changes to the model since you have last saved it, 

Maxsurf will ask you whether you wish to save the design changes. 

 

 Selecting yes will save the changes and clos e the model.  

 Selecting no will not save your changes and close the design. You will lose 

all changes since the last save.  

 Selecting cancel will cancel the close design command and allow you to 

continue working.  

 

Continue with the Chapter 3 User Interface section on the next page.
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Chapter 3 User Interface 

In this training manual it is assumed that the user has a reasonable familiarity 

with working in applications on any Microsoft Windows
®
 operating system. 

Some Maxsurf specifics to the User Interface are described below. It is a good 

idea to read this section before you start modelling, as it will give you a good 

understanding of the architecture of the application which helps you find 

commands faster and operate the program more efficiently.  

 

The User Interface can be defined as the aggregate of tools available that 

allow you to work with the application. Some of these tools can be used for 

viewing while others allow you to control or manipulate the object being viewed.  

 

The Maxsurf User Interface can be divided up into three main groups: 

 Menus  

 Toolbars  

 Windows  

Menus 

Unlike some other CAD applications Maxsurf does not have a command line. 

This has the advantage that you donôt have to memorise different commands and 

everything can be done using the commands in the menus.  

 

To enable faster access to the menu commands Maxsurf has two other options: 

1. Toolbars. The most common commands can also be accessed through 

toolbars.  

2. Additionally, Maxsurf has several object based right click commands. 

This means that after selecting an object and using the right mouse 

button, Maxsurf displays the most commonly used commands on the 

selected object. For example, when you select an edge of a surface and 

right click on it, you can access the Surface Properties or perform a 

trimming operation on the surface.  

These are just other (usually more efficient) ways to get to a corresponding menu 

command. 

 

The menus and toolbars in Maxsurf operate in the same way as most Microsoft 

applications and will not be explained any further. At this stage it is not required 

to know all the menu commands as we will cover most of them as we go along in 

this training manual, but for the interested reader the function of each Menu 

command is explained in detail in the Menus section of the Reference Chapter of 

the Maxsurf manual. 

 

A brief overview of the menus is worth studying: 

 

Menu Description 

File  Working with the file 

Edit Copy & Paste and other editing commands 

View Lets you set how you want something displayed. Often 

confused with the Display menu. 

Markers All commands to do with Markers 

Controls All commands to do with Control Points 
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Curves All commands to do with Curves 

Surfaces All commands to do with Surfaces 

Display Select what you want to display 

Data All commands to do with calculations & producing data 

Window Different window display options 

Help Accessing different Help resources 

 

Toolbars 

The toolbars contain toolbar buttons that activate menu commands. Only the 

most commonly used menu commands are on the default toolbars. Maxsurf 

allows you to create you own toolbars and toolbar buttons. This is not covered in 

the LearningMaxsurf training manual. For the interested reader: information on 

this can be found in the Customising Toolbars section in the Maxsurf Reference 

chapter. 

Windows 

Continue reading the Maxsurf Windows section of this training manual. 

Maxsurf Windows 

Maxsurf consists of a total of 10 windows. Each window has its own 

functionality and usefulness depending on the task that you want to perform. 

You will rarely need all 10 windows at the same time. For example: when you 

are working with Offsets or when you are modelling, there is little need for the 

Calculations window. The Calculations window can then be minimised or closed 

to optimise available screen space. 

 

Within the 10 Maxsurf windows we can identify a group of 4 ñView Windowsò 

that are used to view the model. 

 

Continue reading the 3D Modelling in 4 View Windows section. 

3D Modelling in 4 View Windows 

One of the most difficult things to learn is working in a 3 Dimensional 

environment on a computer screen. Especially if you have never used 3D 

drafting tools before it can take some time to get used to. The Maxsurf 

application is specially designed to help you manipulate a shape in 3D using just 

your mouse and the computer screen display. The tutorials in this document will 

teach you different mouse techniques and screen display settings that increase 

your 3D modelling efficiency in Maxsurf. 

 

Maxsurf consists of four view windows. For each 2D view direction, Maxsurf 

has one window: 

View direction View Window 

Looking from the stern to the bow Body Plan Window 

Looking from the Starboard side Profile Window 

Looking from below* Plan Window 
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* This may appear odd, but this way the user can model above the centreline in Plan view. Research 
has shown that a naval architect can interpret the shape of a vessel in plan view better when it is 

drawn above the centreline. 

 

Body Plan Window 

 

Profile Window 

 

Plan Window 

Finally Maxsurf has a 3D viewing window that allows you to view the model in 

3D, rotate it and render it. This is called the Perspective Window. 

 

Perspective Window 

Continue with the section on Working in Different Windows Layouts. 

Working in Different Windows Layouts 

Window Layouts - Concepts 

Most computers use a 1024 x 768 resolution monitor which means that there 

is limited space available and you continuously have to find a compromise 

between the number of windows you have open and the size of the windows: 
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5 windows open, but each of them is quite small. 

 

Only one window open (Body plan), but now you canôt see the effect of a  
modification to the shape of the design in the Profile, Plan or Perspective window. 

It is really a matter of experience and personal preference what suits your 

working methods best. Here are some tips from the Maxsurf developers: 

Window layout tips:  

- To maximise screen space, it is recommended to maximise the 

Maxsurf application window at all times. 

 

- When modelling, close all windows except for the view windows.  

 

- When modelling, switch between working with 4 view windows 

and just one view window. 

 

- Minimising the amount of information on your screen helps you 

work more efficiently. 

Windows Layout ï Video 

 View a video that shows you the different windows layouts in Maxsurf as 

well as different ways to switch between windows (next section). [Web | Disk] 

Windows Layout ï Procedures 

In the following steps you will learn how to setup your windows layout in 

Maxsurf so that you have just the 4 view windows open. 

ü Start Maxsurf while holding down the Shift key 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/working-in-different-windows-layouts2#CuAwl8tOgsOOGH8gIlNsLQ
TrainingVideos/WindowLayoutP.avi


 21 

ü Select ñyesò to clear all preferences 

This will start Maxsurf with the default windows settings: 

 

ü Use Window | Tile Horizontal 

Youôll see something like this: 

 

Maxsurf windows after Tile Horizontal 

ü Now close all windows except for Body Plan, Profile, Plan and 

Perspective 
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Notice how the closed windows are all stacked at the bottom of the Maxsurf 

application window: 

  

ü Do another Window | Tile Horizontal 

You should now see something like this: 

 

You can re-open any of the closed windows by simply selecting the window 

from the Window menu and the selected window will restore to its original 

position and size before it was closed. 

 

Continue with the Switching Between Windows section. 

Switching Between Windows 

Switching between windows ï Concepts 

A Window can be either in the background (passive/display only) or it can 

be the ñcurrent windowò. A background window is a passive window used for 

display only and you can not type or modify any of the objects in it. Only one 

window can be the current window or active window. In this active window 

objects can be modified (eg. change surface shape or text in a table). 

 

You may click within any window to make it the active window. If you have 

several windows open, you can recognise the active window by the brighter 

colour of the title bar. A window may also be brought to the top by selecting its 

name from the Windows menu. 

Switching between windows ï Procedures 

ü Start Maxsurf while holding down the shift key 
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ü Click yes to clear all saved Preferences 

In the images below the Maxsurf Sample_Trawler design is used. 

 

ü Maximise the perspective window by clicking the  button in the 

top right corner of the window. 

 

This will maximise the Perspective window inside the Maxsurf application 

window: 
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Perspective window maximised inside the Maxsurf application window. 

Note: When a particular window is maximised, the programôs title bar reflects 

which window is being displayed:  

ü Now select Window | Profile 

This switched to the Profile window. Notice how the Window toolbar has 

updated from: 

   
 

ü Now Click on the Restore window button in the top right of the 

Maxsurf application window; 

 

This restored the Profile window to its previous size and location. 

Tip:  

You can also switch between the design view windows by using the 

Window toolbar: . 

Continue with the Assembly Pane section. 

Assembly Pane 

The Assembly Pane is a special case and deserves an extra explanation when 

discussing windows layouts. When used properly, the Assembly Pane can speed 

up your work significantly. 

 

First read about the different modes of operation for the Assembly Pane in the 

Assembly Window section of the Maxsurf manual. 

 

Again, as you get more experienced using Maxsurf you will develop your own 

personal preference with regards to using the Assembly Pane. The experience is 

that having the assembly tree docked on either the right or left side of your 

screen provides quick access to right click commands and speeds up your work.  

Assembly Window ï Video 

 View a video that will show you the different window options for the 

Assembly Pane. [Web | Disk] 

 

Continue with the section on the Properties Pane. 

Properties Pane 

The properties pane is very similar to the Assembly Pane in the way that it can 

be floating, docked or auto hide. The Assembly Pane and the Properties pane can 

also be docked together into one pane or as tabbed panes. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/window-options-for-the-assembly-pane#Nas48wIIQO5SUchlcRrXmA
TrainingVideos/AssemblyWindowP.avi
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Regular docking and floating options for properties pane same as for the Assembly Pane. 

When you drag the Properties Pane on top of the docked Assembly Pane, you 

will see the following: 

 

Properties pane docking position: 

1: Above Assembly pane 

2: To the right of Assembly pane 

3: Below Assembly pane 

4: To the left of Assembly pane 

5: To the left of Assembly pane as a 

separate pane 

6: Underneath the Assembly pane into 

a tabbed pane. 

 

Properties pane docking in the same area as the Assembly pane has different options. 

 

Continue with the section on Working in the Perspective Window. 

Working in the Perspective Window 

Working in the Perspective Window ï Concepts 

We will now explore two viewing options unique to the Perspective window ï 

rendering and rotation. 
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Working in the Perspective Window ï Video 

 View a video that will show you how to rotate the model in the Perspective 

view window using the slider bars and free rotate. The video also shows how to 

render the model and toggle different light sources. [Web | Disk] 

Working in the Perspective Window ï Procedures 

Render 

ü Click within the Perspective window to make it active or use the 

Windows menu or toolbar. 

To get a realistic 3-D representation of the model as a solid body, you can render 

the surface. 

ü Go to Display | Render and ensure that the dialog box appears as 

below before clicking OK: 

 

 

To maximise the light incident on the surface,  

ü Activate the four light sources in the Render toolbar: 

 

The model rendered in Perspective window with all four light sources switched on. 

Note 

Rendering only works in the Perspective window. The Display | 

Render as well as the Render toolbar are disabled when the 

Perspective window is not active. 

Rotate 

The Rotate function lets you freely rotate a design in the perspective window. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/working-in-the-perspective-view-window#U0qr2WO1Lj-XDHoeLZGNBw
TrainingVideos/WorkingInThePerspectiveWindowP.avi
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ü Select View | Rotate or use the  toolbar button from the View 

toolbar 

ü Move the cursor to a location in the Perspective window and press 

the left mouse button  

ü Keeping the left button depressed, rotate the image by moving the 

mouse around 

The rotation is performed by projecting the cursor movements onto a virtual 

sphere in the perspective window centred on the centre of the surface ï 

essentially the rotate function performs like a virtual trackball. Generally 

speaking, moving the mouse left and right rotates the model about a vertical axis 

while moving the mouse up and down rotates it about a horizontal axis.  

ü Release the left mouse button to exit the Rotate mode. 

To rotate the model with greater accuracy and control, you can use the pitch, roll 

and yaw slider bars on the sides of the perspective window.  

ü ñGrabò the yaw control block within the yaw scale by clicking it, 

and while still holding the left mouse button, drag it over the 0 

(degrees) marker.   

ü In the same way, set the pitch and roll to 0 

You should end up with something like this: 

 

1 = Pitch, 2 =Yaw, 3 = Roll 

 

Continue with the section on Displaying Contours. 

Displaying Contours  

Displaying Contours ï Concepts 

An alternative to using rendering to visualise the shape of a surface is to make 

surface contours visible. 

Displaying Contours ï Video 

 Watch a video that will show you how to toggle the display of different 

contour lines in different windows using toolbar buttons and the Contours dialog. 

[Web | Disk] 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/displaying-contours#bDU6QFPlDzmpJ3ncIUMz7Q
TrainingVideos/DisplayingContoursP.avi
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Displaying Contours ï Procedures 

ü In Perspective window, switch rendering off by clicking on the 

 toolbar button 

ü Change the pitch to 15 and the yaw to 45 to better visualise the 

contours 

ü Go to Display | Contours and tick the sections box: 

 

The sections define the intersections between the surface and numerous 

transverse planes through the model. 

 

ü Switch to Body Plan window 

 

ü Now switch to Profile window 

 

Sections are not displayed in the Profile or Plan window 
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Though the sections would appear as vertical lines on the screen in both the 

profile and plan windows, since these lines would bear no information about the 

shape of the sections, they are not displayed.  

ü In the Contours dialog box, uncheck sections but tick the buttocks 

box 

 

ü Switch to the Plan window 

The buttocks define the intersections between the surface and numerous vertical 

longitudinal planes through the model. For the same reasons as above, they do 

not appear in the Plan or Body Plan windows. 

ü In the Contours dialog box, uncheck buttocks but tick the 

waterlines box.  

 

The waterlines define the intersections between the surface and numerous 

horizontal longitudinal planes through the model. For the same reasons as above, 

they do not appear in the Profile or Body Plan windows. 

ü In the Contours dialog box, check Sections, Buttocks and 

Waterlines 

ü Switch to Perspective view 

 

In the Perspective window, all contours are displayed 

 

Continue with the section on Working in the Body Plan window. 
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Working in the Body Plan window 

Working in the Body Plan Window ï Concepts 

The body plan window displays the transverse sections as seen from aft of the 

model. Starboard is on the right of the centreline. Working in the Body Plan 

view window is different to working in Plan or Profile because in Body Plan you 

are looking down the length of the vessel which can appear quite messy. In Plan 

or Profile you are looking from the bottom or starboard respectively and this 

usually does not look quite as confusing: 

 

 
Body plan 

 
Profile 

 
Plan 

 

In the image below, 22 sections are displayed in one 2D window. Even though 

the eye of the naval architect is trained in interpreting images like this and 

translate this into a 3D shape, it can sometimes be difficult to establish the 

longitudinal position of a particular section along the length of the hull. This is 

why the Body Plan window has an extra feature built in: the Control Box. This 

powerful tool allows you to select the station you would like to display or the 

column of control points you wish to modify. This enables you to do some useful 

modelling in the Body Plan window and manipulate the shape by working one 

section at a time. In the procedures below weôll have a closer look at this control 

box. 

 

 

 

You can identify three regions in 

the Body Plan window: 

1. Main view window area  

2. Control box  

3. Coordinate display 

 

Half hull display in Body Plan view  

 

Tip:  As with most Windows in Maxsurf, but especially in the Body Plan view, it 

is important to make sure you display only the data that you need using the 

Contour display dialog or toolbar buttons. 
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Working in the Body Plan window ï Video 

 View a video that will show you the different view options in body plan such 

as Show/Hide Net, Display/Hide Sections and how to use the control box to 

switch between sections or switch your active column of control points.  

[Web | Disk] 

Working in the Body Plan window ï Procedures - Introduction 

Introduction to the Body Plan view window 

ü Open the Maxsurf Sample_Trawler.msd sample file from the 

c:\program files\Maxsurf \Sample Designs directory 

ü Maximise the Body Plan view: 

ü Display only the Edges and the Sections 

ü Select Display | Half or use the  toolbar button 

Working in the Body Plan window ï Procedures ï Control Box 

Using the Control Box 

ü Switch the sections off 

You should now see just one section displayed on your screen: 

 

The control box is a miniature view of the plan shape of all currently visible 

surfaces ï in this case just the one surface modelling the trawlerôs hull.  

 

 

At the top of the control box several short vertical lines are drawn. These are the 

section or station indicators; there is one indicator for each of the sections 

specified in the Grid Spacing dialog. 

ü Click in the control box near the stern of the ship: 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/working-in-the-body-plan-view-window#aWtDF1d_0fN8JgX4CjCHOA
TrainingVideos/WorkingInTheBodyPlanWindowP.avi
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The current section marker line shows which section is currently displayed. 

When a point in the control box is clicked, the nearest section will be selected. 

Notice how in the Body Plan window the current section has changed:  
 

After clicking in the control box, you can use the arrow keys on your keyboard 

to scroll through the sections. The right arrow displays the next station forward 

and the left arrow displays the next station aft. 

ü Use your keyboard keys to scroll through the sections of the 

trawler model 

Working in the Body Plan window ï Procedures ï Half Display 

Half Display 

When working in Body plan you will usually toggle the section display on/off to 

visualise the effect of a change to one section on the 3D shape. When all sections 

are displayed simultaneously, the display can be a bit messy. The Half display 

can then help to clean the display up. 

 

 

 

 

ü Switch Display of sections off 

ü Switch Display | Half off 

Notice how the section is now mirrored to the other side of the centreline. Also 

notice how the control box current section marker is now drawn across the 

centreline. 

ü Switch display of section on 

Notice how the control box now displays all sections with the current section 

marker drawn with a thicker line: 
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Control box with all sections displayed and half hull display off 

ü Switch Display | Half on 

 

Control box with all sections displayed and half hull display on 

When Half hull display is switched on, Maxsurf automatically determines which 

sections will be displayed on the right and which on the left of the centreline. 

There is a way for the user to overrule this default split location on a surface-by-

surface base. This is not covered in the LearningMaxsurf training manual. 

Note:  

When the cursor is within the control box the horizontal cursor 

coordinate at the bottom of the Body Plan window refers to the 

cursorôs longitudinal position within the control box. 

 

For the control box to work correctly it is important that the Frame 

of Reference is setup correctly. You will learn about this later; just 

remember this at this stage. 

 

Continue with the section on Zoom, Shrink and Pan.  

Zoom, Shrink and Pan 

Zoom, Shrink and Pan ï Concepts 

In all Maxsurf view windows you can zoom, shrink and pan to manipulate the 

way that the model is displayed. Additionally Maxsurf lets you set a Home view 

that remembers a particular zoom & position of the model on the screen. 

Zoom, Shrink and Pan ï Video 

 View a video that shows the use of zoom, shrink and pan commands. This 

video also shows how to customise the home view to your own personal 

preference and use the Home view command. [Web | Disk] 

Zoom, Shrink and Pan ï Procedures - Zooming 

Zoom 

The Zoom function allows you to work on any part of your design by enlarging a 

particular area to fill the screen. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/zooming-shrinking-panning-and-home-view#BopxBlS_apLIz2sxOLW46A
TrainingVideos/ZoomShrinkPanHomeViewP.avi
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The zoom function works in any of the Maxsurf drawing windows. To 

demonstrate how it works,   

ü Click on or otherwise activate the Profile window 

ü Select Zoom from the View menu (or use the keyboard equivalent 

Ctrl+E).  

A cross hair will appear that follows the movement of the mouse. This is used to 

set the starting position of the zoom rectangle. Supposing we wish to zoom in on 

the bulbous part of the bow profile: 

ü Click and hold the mouse from approximately this position: 

 

ü Drag the mouse to form the following zoom rectangle: 

 

The zoom rectangle will grow as the mouse moves.  

ü Release the mouse button. 

The view contained in the zoom rectangle will be enlarged to fit the screen. 



 35 

 

There is a limit on how far you can zoom; you will find that after continual 

zooming the image will not enlarge any further. 

Note:  

If, before releasing the mouse button, you decide that you do not 

wish to use Zoom, or that you wish to change the starting position 

of the zoom rectangle, simply return the cursor to within a few 

pixels of the starting position, release the mouse button, and the 

cross hairs will reappear. 

Zoom, Shrink and Pan ï Procedures - Shrinking 

Shrinking 

Choosing Shrink will reduce the size of the displayed image in an active drawing 

window by a factor of two.  

 

To shrink the displayed image: 

ü Select Shrink from the View menu. 

Tip: You can also use the shortcut key Ctrl + R or the  toolbar button.  

ü Shrink the image until the entire profile is contained within the 

Profile window 

 

Zoom, Shrink and Pan ï Procedures - Panning 

Panning 

Choosing Pan allows you to move the image around within a drawing window.  

To Pan an image: 

ü Select Pan from the View menu.  
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ü Click anywhere within the window and drag the drawing to a new 

position, 

 

The image will move with the cursor until the mouse button is released. 

 

Tip: you can also use the  toolbar button or hold down the scroll wheel of 

your mouse to Pan.  

Zoom, Shrink and Pan ï Procedures ï Home View 

Home View 

When you select Home View a zoomed or panned image is returned to a 

particular state. This state may be set at any time for any combination of 

zooming and panning by selecting Set Home View from the View menu. 

ü In Profile view, zoom in on the bulbous bow again 

ü Select View | Set Home View 

ü Now Zoom out a couple of times 

ü Select View | Home or use the  toolbar button 

 

Notice how the display returns to the Home view as you specified it earlier.  

Note:  

Maxsurf starts up with default Home View settings, which are based 

on the Home Views in use the last time the program was operated. 

 

If a Home View is set within the Perspective window, the specific 

rotational orientation of the model will not be restored if the model 

is rotated and Home View is selected.  

 

Continue with the section on Measuring Coordinates in Maxsurf.  

Measuring Coordinates in Maxsurf 

Measuring Coordinates in Maxsurf - Concepts 

Maxsurf has defined its views to be consistent with Naval Architecture standards 

throughout all view windows.  
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+ve forward  -ve aft 

+ve starboard -ve port 

+ve up  -ve down 

 

Window View direction 

Body plan Looking forward from the stern 

Profile view Looking from starboard, bow to the right 

Plan view  Looking from below, starboard above the centreline 

 

In the case of the sample trawler, the origin of the coordinate system at the 

forward-most point on the modelôs waterplane, as illustrated by the  symbol in 

the profile view of the trawler:  

 

 In the design view windows, other than the perspective view, Maxsurf displays a 

number of co-ordinates and measurements in the bottom-left corner of the 

windows. 

Measuring Coordinates in Maxsurf ï Video 

 View a video that will show you how to measure absolute and relative 

coordinates and angles in Maxsurf. [Web | Disk] 

Measuring Coordinates in Maxsurf ï Procedures 

To ensure that coordinates are interpreted correctly, the units must be set as 

desired. 

ü Select Units from the Data menu and select Metres for Dimension 

Units.   

ü In the Profile window, left-click the aft intersection of the datum 

waterline and the surfaceôs edge. (Point A)  

ü Now move the cursor towards the bow and hover at point B. As 

you do so, watch the coordinates change in the coordinate bar in the 

bottom of the Profile window. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/measuring-coordinates-in-maxsurf#lP9PZu94X0OmgZ8x1knzqg
TrainingVideos/MeasuringCoordinatesP.avi
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1. The horizontal coordinate in metres of the cursorôs tip (Point B relative to the 

origin). The horizontal axis is relative to the screen, e.g. here the horizontal 

axis runs longitudinally but in the body plan view the horizontal axis runs 

transversely. 

2. The vertical coordinate in metres of the cursorôs tip (Point B relative to the 

origin). 

3. The counter-clockwise angle in degrees between a line connecting the 

cursorôs tip (B) and the clicked point (A) and a line running right from the 

clicked point (in this case the waterline to the right of point A). If no point 

has been clicked, the angle is relative to the origin. 

4. The relative distance in metres between A and the cursorôs tip B. If no point 

has been clicked, the distance is relative to the origin. 

 

Continue with the section on Using the mouse in Maxsurf. 

Using the mouse in Maxsurf 

This section describes different mouse techniques that you can use throughout all 

of the Maxsurf applications. 

Right Mouse button 

Maxsurf supports several right click mouse actions. Right clicking on selected 

objects brings up a so called ñright click menuò that lists the most commonly 

used commands applicable to that object. For example after right clicking on a 

surface in the Assembly Pane can give you quick access to the Surface 

Properties: 

 

Right click menu 
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Using right clicking can greatly speed up your work.  

Using the Mouse Wheel 

You can use the mouse wheel to easily zoom into and out of a design. You can 

use this feature if you have a mouse with a ówheelô in the centre of the mouse, 

i.e. Microsoft Intellimouse or Logitech Wheelmouse.  

 

Rolling the wheel forward zooms in and rolling it backwards zooms out. When 

zooming in with the mouse wheel, the zooming will be centred on the centre of 

the drawing window. To zoom in on a particular area, View | Zoom or Ctrl + E 

must be used.  

 

Holding down the mouse wheel to pan is also supported. 

 

Continue with the section on Undo / Redo. 

Undo / Redo 

Since a lot of work in Maxsurf is iterative and based on trial and error, it is 

important to make note of the Undo and Redo capability in Maxsurf.  

 

Changes can be Undone from the Edit menu. An action that has been Undone 

can be redone from the Edit menu as well. In the image below you have the 

option to redo the deletion of the surface, or undo the most recent control point 

move.  

 

Each time a change is made Maxsurf stores a copy of the file into the RAM 

memory of your computer. The number of Undo levels that Maxsurf stores is set 

in the Edit | Preferences.  

 

Tip 

The fastest way to Undo and Redo is by using the Ctrl + Z and Ctrl 

+ Y shortcut keys respectively. 

 

Save regularly. Additionally use different file names if radical 

changes are made to the model. 

Congratulations! You have now completed the Chapter 3 User Interface. 

 

Continue with the Chapter 4 NURB Surfaces section on the next page. 
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Chapter 4 NURB Surfaces 

Before you can start to create your first model it is important to understand the 

basic principles of surface modelling in Maxsurf. Understanding the basic 

principles behind NURB surfaces will improve the quality of your Maxsurf 

models and your ability to produce them significantly. 

ü  Read Chapter 2 of the Maxsurf manual on Basic Principles 

(Ignore the link to ñWorking with Surfacesò). 

From this you should at least remember: 

1. That the net of control points is always topologically quadrilateral; there 

are four corner control points and four edges. The control point net is 

arranged in rows (which run longitudinally) and columns (which run 

transversely). Each row has the same number of control points as every 

other row and each column has the same number of control points as 

every other column. 

2. A surface always consists of 4 corner control points and may consist of 

additional edge control points and internal control points. 

 

Continue with the section on Surface Stiffness. 

Surface Stiffness 

Surface Stiffness ï Concepts 

In Chapter 2 of the manual, the stiffness of a spline curve was compared to 

the stiffness of springs altering the shape of a wooden spline/batten. This analogy 

also holds when you think of the fact that if the wooden spline itself were stiffer, 

its curvature when loaded transversely would be lesser. Similarly: when drawing 

a smooth shallow curve you could select a stiff spline, and when drawing a curve 

featuring a high rate of change of curvature you could select a flexible spline. 

 
A Perspex batten is used to draw a spline. Its stiffness determines how much curvature can be 

drawn. 

In Maxsurf there are a number of stiffness levels or ñordersò for both the 

longitudinal and transverse directions of the surface:  

 

Linear Order 2 

Flexible Order 3 

é. é.. 

Stiff Order 10 

 

The order reflects the number of coefficients used in the polynomial that 

describes the splineôs shape. For example: the order 2 polynomial 

ñ bxay ò uses 2 coefficients óaô and óbô and describes a straight line (read: 

linear curve). 
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When using NURB surfaces, flexible surfaces are useful for modelling knuckles 

(a region on a surface with sudden or very high change in curvature) and 

discontinuities. 

Surface Stiffness ï Video 

 Watch a video that shows you the effects that a change to the surface 

stiffness has on the shape of a spline. [Web | Disk] 

 

 Watch a video that shows how a change in stiffness affects the shape of the 

surface. [Web | Disk] 

Surface Stiffness ï Procedures ï 2D Curve 

2D Curve 

In the section on Basic Fairing we will discuss stiffness further, but first letôs 

have a look at the effects of stiffness on a curve: 

ü Maximise the Profile window 

ü Open SurfaceStiffness2D_start.msd  

 

The model consists of a single chain (or ñrowò) of control points that produces a 

spline that lies in a single plane (you can see this in the Plan and Body Plan 

windows). Thus the model is best viewed in the Profile window. The ócurveô 

produced is simply a jagged line connecting the control points. 

ü In the Assembly pane on the left, right click the surface 2D Curve 

and open the Properties dialog. (If the assembly plane is not visible, 

go to View | Assembly). 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/effects-of-surface-stiffness-on-a-2d-curve#4uU7jvW9i7JVhsF99qRWqQ
TrainingVideos/SurfaceStiffness2DP.avi
http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/effects-of-surface-stiffness-on-a-3d-surface#9DY7fURZGZR5bxgOpNF_yg
TrainingVideos/SurfaceStiffness3DP.avi
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Currently, the transverse surface stiffness is set to 2 (linear).  

ü Increase the longitudinal surface stiffness to 3 (flexible). 

The curve now remains closer to the line between end control points. Note that 

the curve runs at a tangent to the control point net (blue) at the end points. This is 

true for splines of all stiffness orders. In the case of an order 3 spline, the curve is 

also tangential to the control point net at the midpoint of the net lines between 

successive intermediate control points (i.e. at  points A and B below): 

  

ü Undo (Ctrl + Z) and Redo (Ctrl + Y) the change in stiffness to best 

study the effect of the change 

ü Increase the longitudinal surface stiffness to 4, then 5  

Notice how the spline displaces less and less from the line between the end 

control points.  

ü Try  selecting a stiffness of order 6 from the longitudinal stiffness 

drop-down menu. What happens?  

A stiffness of 6 is not allowed because the order of the surface stiffness in a 

given direction must be less than or equal to the number of control points in that 

direction. Here there are 5 control points in a row so the maximum stiffness in 

the longitudinal direction is 5.  
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 The reason for this relates to the mathematical definition of a spline of 

certain stiffness or order. If a polynomial has five constants, at least five points 

on the curve (or influencing the curve, like the control points) are required to 

solve the constants and define the curve.   

Note:  

Maxsurf will make sure the stiffness of the surface cannot be greater 

then the number on control points in that direction; i.e. if you have 

an order 6 surface and you reduce the number of columns from 6 to 

5, Maxsurf automatically reduces the surface stiffness from 6 to 5. 

Surface Stiffness ï Procedures ï 3D Surface 

3D Surface 

To extend the concept of surface stiffness from a curve to a surface,  

ü Open SurfaceStiffness3D.msd. If prompted to locate the materials 

and shapes library, click Cancel.  

To best view the effect of changing the stiffness of the surface,  

ü Maximise the perspective window. 

ü Set pitch to 0, yaw to 60 and roll to ï60. 

ü Go to Display | Net and select Show Net to view all control points 

and the net.  

ü Go to Display | Contours  and turn on sections and buttocks. 

The surface stiffness is initially set to 2 (linear) in both directions. Notice that the 

sections and buttocks follow the shape of the control point net perfectly.   

  

ü Change the stiffness is both directions to 3. 

Notice how the longitudinal surface edges and the buttocks, as well as the 

transverse surface edges and the sections have smoothed away from the control 

point net.  
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ü Change the stiffness in the transverse direction to 4 and in the 

longitudinal direction to 5 (the limits).  

Observe how the edges, sections and buttocks are even smoother and that the 

entire surface is more planar.  

 

 

Continue with the section on Surface Precision. 

Surface Precision 

Surface precision - Concepts 

In the previous sections you have learnt that NURB surfaces consist of control 

points and certain stiffness properties. In this section you will learn about what 

Maxsurf does with this surface information in order to display the shape of the 

surface. 

 

The NURB surface shape is defined solely by: 

 The surface stiffness  

 The position of the control poin ts 

 The weight of the control points (recommended to leave at weight = 1) 

 

Based on these three ingredients, Maxsurf can calculate the shape of the surface 

at any given point on the surface. For example, Maxsurf can calculate the 

position halfway along one of the edges, or at any random location inside the 

surface. This way Maxsurf can theoretically turn a NURB surface into a point-

mesh with infinite density. However, this calculation would take an infinite 

amount of time and saving this mesh to a file would result in a file of infinite 

size. Alternatively, Maxsurf can divide the surface up into a mesh with a specific 

number of segments along each edge (for example 16 segments). This would 

result in 16 x 16 = 256 mesh points which can be used to display the shape of the 

surface or exported into a data file. This mesh is called the ñParametric Meshò. 

The number of segments in this Parametric Mesh is determined by the Surface 

Precision. 

The number of segments used to display the shape of the 

surface is set by th e Surface Precision.  

 

Below you will look at the shape of the trawler sample design at different 

precisions: 
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Surface mesh with 8 segments Surface mesh with 32 segments 

Surface precision - Procedures 

ü Open the Maxsurf Sample_Trawler.msd file from c:\Program 

Files\Maxsurf \Sample Designs 

ü Go to Windows | Plan 

ü Display | Precision | Medium 

ü Display | Contours | Parametrics or use the  toolbar button. 

 

You should see something like this: 

 

At Medium precision there are 32 line segments along each edge.  

ü Now switch Data | Precision to Lowest: 

 

At lowest precision there are 8 line segments along each edge 

Notice that each line segment is drawn by a straight line. 

ü Now switch to Data | Precision | Highest 
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Highest precision starts with 64 segments and inserts more where it needs to for greatest accuracy. 

It is beyond the scope of the LearningMaxsurf training to go into details any 

further. All you need to remember is that the Precision setting does not change 

the shape of the surface (shape is determined only by stiffness and control 

points), but determines how many line segments are used to display the shape. 

 

In the rest of the LearningMaxsurf training you will only work at the default 

precision (medium). 

 

Continue with Chapter 5 Designing in Maxsurf.
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Chapter 5 Designing in Maxsurf 

When designing in Maxsurf, a naval architect has several options to choose 

from: 

 Use a similar existing design and modify it to design requirements  

 Start from a new design scratch  

 

Which of these options is most cost efficient is difficult to predict and dependent 

on: 

The required hull shape 

The Maxsurf Sample Designs directory contains a wide range of hull forms that 

can be used as a starting point. If the shape of the intended design is close that of 

one the sample designs, it will save you a lot of time if you use the sample 

design as a starting point. It is definitely worth while familiarising yourself with 

the sample designs in: c:\program files\Maxsurf\Sample Designs. 

The purpose of the surface model and surface type 

If your model is used for production purposes then it will need to be created from 

a faired NURB surface, the user will have to think carefully about the surface 

topology of the intended design before starting. The reasons for this are 

explained further in the intermediate section of this training manual.  

 

If the model is intended only for analysis purposes, then hull shape can be 

created as a TriMesh Surface. A TriMesh surface is a linear surface made up of 

triangular facets. It is not a NURB surface, it does not have control points, and it 

cannot be trimmed with NURB surfaces. 

 

The TriMesh surface is not designed to be smooth ï it follows the input data 

points exactly and is linear between the data points. The Markers should provide 

sufficient detail for the purpose to which the model is going to be put such as, for 

example, hydrostatic and/or seakeeping analysis in Hydromax, Seakeeper and 

Hullspeed. 

 

For more information see the section on Generating a TriMesh surface in the 

Maxsurf User manual and Importing dxf Marker Data & Generating a TriMesh 

model Tutorial. 

The userôs experience in Maxsurf 

An experienced user may get to a good starting point for a hullshape much faster 

than a new user. A new user to Maxsurf may feel more comfortable starting with 

a similar existing design, while a more experienced user can make a design 

completely to his own liking by starting from scratch. 

 

Note that the dimensions and the design category (eg leisure vs. commercial etc) 

are not in the above list. A sailing boat hull shape may offer a good starting point 

for a frigate for example. Maxsurf offers a range of tools to quickly resize 

surfaces. In Maxsurf Pro there are even tools to change design coefficients such 

as LCB, Cb and Cm etc. Letôs first get an idea of what is involved in starting a 

Maxsurf design from scratch. 
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Letôs get started! Go to the Starting a Design from Scratch section. 

Starting a Design from Scratch 

 When you start a design from scratch, you literally start with a blank piece 

of paper. Earlier in this training manual the use of Maxsurf was compared with a 

creative process like painting. Imagine that a painter wants to paint a portrait of a 

person in front of a backdrop of trees and mountains. How and where should the 

painter start painting? He can choose many different ways and each painter will 

chose differently. This is very similar in Maxsurf: the designer has a vision of a 

design and a blank piece of paper (or 3D space). His creativity as well as a good 

knowledge of the tools available to him will enable him to achieve his vision 

step-by-step. The order in which he does things and the tools he uses along the 

way are not pre-defined and can not be learnt from a book. This section of the 

training manual teaches you one particular way of starting a design from scratch 

and teaches you the use of several design tools along the way. This will help you 

achieve your vision of a design in your own creative way. 

 

Start with the Starting a Design section. 

Starting a Design 

Starting a Design ï Concepts 

Before you can start modelling it is a good idea to create the environment in 

which the design will be created. Compare this to choosing the size and materials 

of a canvass in the case of the painter if you like.  

Starting a Design ï Video 

 Watch a short video that shows you the first steps of starting a design from 

scratch: Starting a New Design, Inserting a Default surface, techniques to add 

rows and columns of control points in different windows, saving your design. 

[Web | Disk] 

Starting a Design ï Procedures ï New Design 

New design 

If you have an existing design open, first close it: 

ü From the File menu select File | Close Design  

Now start a new design: 

ü Select File | New Design from the File menu 

This will give you a blank workspace without any surfaces. In the following 

series of tutorials you will model a single surface monohull with a round-bilge 

hull form: 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/starting-a-design#45aM144_2TMvwomaZreHFQ
TrainingVideos/StartingADesign1P.avi
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Starting a Design ï Procedures ï Adding a Surface 

Adding a Surface 

The first thing to do is add a surface, so that you can then manipulate this into 

the required shape. 

ü From the Surfaces menu select Surfaces | Add Surface | Default 

The ñdefaultò surface is a good starting point for most designs. 

 

The diagram below is similar to what should be shown on your screen (Note that 

the display may vary due to the display settings you are using): 

 

Before you start modelling, you should set up the units and overall dimensions 

for your design. 

Starting a Design ï Procedures - Units 

Units 

Select the units you would like to use 

ü From the Data Menu select Units 

ü Complete the dialog box as follows: 
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Note that the units you have selected are saved as Maxsurf preferences and are 

not stored with the design. 

Starting a Design ï Procedures ï Sizing Surfaces 

Sizing Surfaces 

Now we can make the surface approximately the correct size for the design.  

ü Select Surface | Size Surfaces 

  

This dialog may be used to resize one or a selection of surfaces in the design.  

ü Place a tick next to the surfaces you wish to resize 

ü Enter the values as in the dialog image above. 

Starting a Design ï Procedures ï Saving  

Saving Your Design 

You now have a single surface that can be manipulated into the required design. 

At this stage it is a good idea to save your design. To do this, make sure that you 

have activated one of the View Windows and choose: 

ü  File | Save Design As, specify where you wish it to be saved and 

name the file MyFirstDesign_start.msd 

You should get into the habit of regularly saving the design before and after 

major design changes. This is easily done by clicking on the save icon  or by 

using the shortcut Ctrl+S. 

 

Maxsurf only allows you to save your surface model when you have one of the 

View Windows (i.e. Body plan, Profile, Plan or Perspective) frontmost or 

ñactiveò. All Maxsurf applications work this way. You can see how this works 

by: 

ü Switching to the Control Points window 
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ü Going to the File menu 

Notice how the ñSave Designò has changed into ñSave Control Pointsò 

ü Switch back the Body Plan window 

Starting a Design ï Procedures ï Adding Control Point Rows 

Adding Control Point Rows 

The default surface contains 3 rows and 3 columns of control points. To get the 

shape you desire, it may be necessary to increase the number of rows and 

columns in the surface. In this section we will take a closer look at how to add 

and remove control points in the net. 

Tip:  

Always try and use the minimum number of control points to 

achieve the desired surface shape. You will learn why this is in the 

section on Basic Fairing. 

The number and position of the control point rows affects the surfaceôs shape in 

Body Plan view. Adding control point rows will give you more control over the 

section shape. 

Note:  

You can add and delete control point rows only in the Body Plan 

window. 

ü Switch to Body Plan view   

To add a control point row, it is best to turn off the net so that you can only see 

one control point column.  

ü Make sure the net is turned off, you can do this from the menu 

(Display | Net) or  

To add a row, go to the body plan view, select Controls | Add Row or click the 

 toolbar button. You will see a crosshair appear. 

ü Insert a control point row as in the figures below 
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ü Switch to Perspective view 

ü Switch the Net on, Half on, and Hide the Grid from the Display 

menu: 

 

Default surface with the extra rows. 

Notice that the row is inserted into all the columns. Maxsurf will interpolate the 

insertion point in the other columns based on the position where you inserted the 

row into the current column.  

ü Remember to save your design regularly 

Starting a Design ï Procedures ï Adding Control Point Columns 

Adding Control Point Columns 

After adding the rows, you can now proceed to add some columns. Adding rows 

or columns does not have to be done in any particular order. The number of 

columns affects the shape of the surface in Profile and Plan view. Adding control 

point columns gives you more control over the waterlines and buttocks. Adding 

control point columns work exactly the same as adding rows, except it can only 

be done in Plan and Profile view. 

Note:  

You can add and delete control point columns in Plan and Profile 

window. 

ü Switch to Profile view  and turn on the Net .  

Control point columns are added by clicking at a position on a row of control 

points. For example: 

 

Clicking here: 

 

 

Will insert a column here: 
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Clicking here: 

 

 

Will insert a column like so: 

 

ü Insert two columns of control points so that your design looks 

something like this in Profile view:  

 

Starting a Design ï Procedures ï Deleting Control Points 

Deleting Control Points 

Deleting a control points row or column is easy. In this section we will delete a 

control point row from the body plan view. 

ü Switch to the Body Plan window and hide the net  

ü Select Controls | Delete Row or click the Pac-Man  toolbar 

button 

ü Place the jaws of the Pac-Man over the control point row you wish 

to delete and click the left mouse button 

 

 

 

ü Switch to Perspective view 

ü Render the Surface in Smooth Shading: 

 

ü Save your design as MyFirstDesign_Start.msd 

Feel free to practise adding and deleting rows and columns. It may be a good 

idea to save your design first. 

 

Continue Design Preparation. 



 54 

Design Preparation 

Design Preparation ï Concepts 

After you have setup your surface to be roughly the right size and inserted the 

number of rows and columns that you expect you will need to achieve the 

required shape, there are a few things you have to do before you can start 

manipulating the shape of the surface. 

 

Note that the order in which things are done in this tutorial is not a set sequence 

of steps and you are free to do whatever you like at any point during the design 

process. The sequence in this tutorial ensures that you have for example your 

surfaces roughly the right size before you setup your grid so that you only have 

to do that once. 

Design Preparation ï Video 

 Watch a short video that shows you how to setup the Frame of Reference 

and the Zero Point and define the Grid. [Web | Disk] 

Design Preparation ï Procedures ï Surface Properties 

Set Surface Properties 

Before moving the control points in your design, you should review the surface 

properties. In general, you should select a B-Spline surface with the maximum 

stiffness that will give you the surface you require. This will be an iterative 

process, since the number of control points defining the surface limits the 

maximum stiffness. 

ü Rename the surface and set the surface stiffness to the values in 

the dialog below 

 

ü Make sure that the surface is symmetrical. 

ü Save your design as MyFirstDesign_Preparat ion.msd 

We will look at the other surface properties later, for the moment this is all you 

need. 

Design Preparation ï Procedures ï Frame of Reference 

Set Frame of Reference and Zero Point 

Before proceeding to far into the design, you will want to set up a Frame of 

Reference and Zero Point from which measurements are taken. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/design-preparation#H6RYEaUiLAyyA6WzYkFEpA
TrainingVideos/StartingADesign2P.avi
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ü First, select Data | Frame of Reference  

This will bring up the Frame of Reference dialog which allows you to position 

the zero point, datum waterline, baseline and fore and aft perpendiculars: 

 

The dialog shows a profile view of the vessel with the zero point ó+ô and the 

Frame of Reference (forward and after perpendiculars, midships, baseline and 

design waterline). The dialog radio buttons, edit boxes and buttons are arranged 

in two groups: The first defines the longitudinal data for the frame of reference 

and the zero point and the second group defines the vertical. It must be 

remembered that all measurements shown are with respect to the ñcurrentò zero 

point: that is the zero point that was in effect when the dialog was opened. 

 

First set the longitudinal position of the new proposed zero point, under the 

longitudinal datum: 

ü Tick the <Other> radio button   

ü Press the <Aft extent> button  

This moves the longitudinal position of the new proposed zero point to the aft 

extent of the hull. 

 

Now set the vertical position of the zero point, under the vertical datum: 

ü Tick the <Baseline> radio button   

ü Press the <Find base> button  

This moves the vertical position of the zero point to the base line and then finds 

the baseline for the hull. 

 

You will notice that in the Frame of Reference dialogue box the current zero 

point is drawn as well as the new proposed zero point. The new proposed zero 

point is drawn in a pastel shade of the current zero point. 
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Now set the location of the datum waterline. Note that this is relative to the 

current zero point. In the datum waterline box 

ü Type in <-5m > 

This sets the datum waterline to a vertical distance of -5meters from the current 

zero point (+3m from the new proposed zero point) 

 

 
 

 

 

Now to set the longitudinal locations of the forward and aft perpendiculars: 

 

Under longitudinal Datum, next to the Aft Perp: 

ü Press the <Set to DWL> button  

Under longitudinal Datum, next to the Fwd Perp: 

ü Press the <Set to DWL> button  

This sets the forward and aft perpendicular to the current location of the datum 

water line. 
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Design Preparation ï Procedures - Grid 

Insert a Grid 

Before you can start modelling, you need some way to visualise the surface 

shape while you are modelling. At this stage of design it is therefore necessary to 

create a grid of sections, waterlines, buttocks and maybe also diagonals. These 

contours may then be displayed on the design while modelling. 

ü Go to Data | Grid Spacing 

Youôll see the following dialog appear:  

 

The dialog can be divided up into the following regions: 

1. Select the type of grid you want to work on, i.e. Sections, Buttocks, 

Waterlines or Diagonals 

2. Commands to Add, Delete, Sort or Space the grid type selected in 1. 

3. Displays the current grid locations for the grid type selected in 1. 

4. OK and Cancel to confirm or undo all changes made in the dialog. 

ü Select Sections 
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ü Click on the Add button to add Sections: 

 

ü Add 20 Sections and click OK 

This will return you to the Grid Space dialog, which now shows the Grid on the 

left (region 3 in the image of the Grid Space above). Next step is to specify the 

location of the Section lines. You can do that for each section individually by 

typing in region 3 directly, or ï much faster:  

ü Click the Space button: 

 

The Space dialog allows you to Space any number of selected sections over any 

distance you specify. In the Maxsurf Intermediate training we will look at some 

more advanced use of this dialog, but for now: 

ü Space the Sections Evenly along the Length of the model and click 

OK 

Notice how all Sections are evenly spaced from 0 to 40 m: 
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Do NOT click OK in this dialog yet. You will first: 

ü Insert 4 Buttocks spaced evenly along the width 

ü Insert 5 Waterlines spaced evenly along the depth 

ü Click OK  now 

ü Go to Perspective window, switch the Net off, Half on, and display 

Sections, Buttocks and Waterlines: 

 

You can now also Toggle the Grid display on/off from the Display | Grid menu 

or using the  toolbar button. Note that this adds a lot of additional lines to the 

display, especially in Perspective view, and may confuse you. Remember that 

efficient modelling is all about displaying the least amount of information 

necessary. 

ü Remember to save your model 

ü Save your design as MyFirstDesign_Preparation.msd 

 

You now have a basic surface with a Zero Point, Frame of Reference and a grid. 

The surface is approximately the correct length. 

  

Continue with the section on Modelling . 
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Modelling Corners and Edges 

Modelling Corners and Edgesï Concepts 

After you have set up a surface with approximately the right size, stiffness 

and number of control points and have also defined a grid, zero point and Frame 

of Reference, you can start shaping the design. Again you can do this in any 

random order you like, but from the authorôs experience there is a particular 

sequence that works very well and it is recommended to follow this for now. The 

most efficient way to manipulate the shape of this surface is by working your 

way through the three types of control points from top to bottom:  

  Corner control points  

  Edge control points  

  Internal control points * 

* If the difference between corner, edge and internal control points is not clear, read Chapter 2 of 

the Maxsurf manual. 

 

Following this order will prevent you from making unnecessary adjustments to 

internal control points and reduce the number of iterations you will have to do to 

achieve the desired hullshape. 

 

Just to recap on the previous section in this training where we explored the User 

Interface, here are some tips and tricks that are worthwhile remembering when 

manipulating the shape of a design: 

1. An adjustment to the shape in a 2D window influences the 3D shape and 

thus in the other 2D windows and Perspective window. 

2. Alternate between different view windows regularly when modelling 

3. When starting a new model, make big changes first whilst alternating 

between view windows and then slowly refine towards to required 

shape. Donôt try to do it all at once in just one view window. 

4. Arranging your view windows can improve your productivity. For 

example: you can show all four view windows at the same time and see 

how a change made in one window effect the hullshape in the other 

windows. 

Modelling Corners and Edges ï Video 

 Watch a short video that shows you how to set the 4 corner control points 

positions numerically, and then manipulate the edges in the different view 

windows. This video also shows how to use the Control Box in Body Plan view 

is used to activate different columns of control points. [Web | Disk] 

Modelling Corners and Edges ï Procedures ï Corner Control Points 

Positioning the Corner Control Points 

Each surface consists of four corner control points. The corner control points can 

be recognised by their colour or by following the edges to the surface:  

 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/modelling-corners-and-edges#EJ1BQ4IW17GmavZMd_iioA
TrainingVideos/StartingADesign3P.avi
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Note:  

The location of the corner control point is the exact location of the 

surface.  

For a design that consists of only one surface, the location of the four corner 

control points are more or less determined by the designôs Length, Beam and 

Depth parameters as in the following table. 

 

  

Corner 

control 

point 

Position 

Height Offset Longitudinal position 

1 Top of bow Centreline Fwd extremity 

2 Top of 

transom 

Beam at 

transom  

Transom aft position 

3 Lower 

transom 
Centreline Transom aft position 

4* ? Centreline ? 

* Corner control point number 4 is always very difficult to position. 

ü Enter the following coordinates for the four corner control points 

by double clicking on each of them.  

Perspective is probably the best window to select the corner control points. 

Corner 

control 

point 

Position from zero point 

Height  Offset Longitudinal 

position 

1 9 0 42 

2 7.5 4 0 

3 0.5 0 0 

4 0.5 0 39 
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When you look at your surface now in the different view windows, it looks 

pretty messy. Donôt worry about this at the moment and more importantly: donôt 

try to fix it by starting to randomly drag control points around. Trust on the fact 

that the order of modelling: Corner control points Č Edge control points Č 

Internal control points will sort it all out for you. Letôs continue modelling by 

manipulating the edge shapes. 

ü Save your design MyFirstDesign_CornersEdges.msd 

Modelling Corners and Edges ï Procedures ï Edge Shape 

Manipulate the Edge Shape 

ü First read Chapter 3, section Moving Control Points of the 

Maxsurf manual 

To make sure you do not get confused by the large number of control points,  

ü Hide the Net , switch buttocks off  

This hides the internal control points, so that you can concentrate on the shape of 

the edges. You can now begin to manipulate the default surface into the required 

design shape. This is simply a case of dragging the control points to their 

required positions. In general, it is best to define the edges in the following 

order:  

ü Switch to Profile View 

When manipulating the edge shape in Profile view, move the control 

points primarily up and down. Out of edge 1, 2 and 3 in the image below 

you can start with any edge you like. Edge 4 (transom) will be adjusted in 

Body Plan view. 

ü Drag the control points so that it looks something like this:  

 

Tip:  

Try not spending too much time on achieving the exact control 

point positions at this stage. Modelling is an iterative process where 

you increase the accuracy of the control pointsô positions as the 

design progresses. 

 

You can see that the surface edge contour does not go through the 

position of the edge control point. This means that typing in the 

numerical values of the edges is not very useful. Remember to 

imagine the surface being connected to the control points via little 

springs or rubber bands.  

ü Switch to Plan View, switch waterlines off , Half off, Hide Net. 

In Plan view you shape the deck edge. You will see that your design 

currently looks something like this: 
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First thing we need to do now is use a multiple selection on edge # 2 (the 

bow) like this:  

 

With these edge control points selected,  

ü Controls | Control Properties 

ü Specify Offset = 0 and OK to move all control points to the 

centreline and close the bow 

 

 

In the control properties dialog all properties that the selected control 

points have in common are displayed. In this case the selected control 

points do not share the same row number, longitudinal position, offset or 

height, but do all have a weight factor of 1.000 and are all in column 4 on 

the Hull surface. 

ü Switch to Perspective view to check your work so far: 

 

Perspective view with sections displayed 
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Smooth Shading rendering in Perspective view 

Note:  

When you are shaping your edges, do not: 

     - touch your corner control points anymore 

     - display your internal control points by showing the Net. 

ü Switch to Body Plan View, Hide Net, Sections off, Half on. 

What you are looking at now is called the active column. When the Net is 

hidden in Body Plan view, the only control points youôll see in Body Plan 

view are the ñactive columnò control points. Active column control points 

are the control points on the column that is associated with the control 

point that you selected last. 

 

Letôs have a look how this works: 

ü In Perspective view Select the following control point in the bow 

column: 

 

ü Switch back to Body Plan: 

 

1 = Section, 2 = Transom edge, 3 = Bow column of control points, 4 = Deck edge. 
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ü In Perspective window, select this control point: 

 

In Body Plan youôll see this column is now the active column and the deck edge 

control point is selected: 

 

The column that  is displayed in Body Plan view when the 

Net is Hidden is called the ñactive columnò. This is the 

column with the last selected control point in it.  

The active column is indicated in the Body Plan window control box: 

 

The control box shows that there are 5 columns on this surface 
of which the 3

rd
 is the active column. 

You can also switch active columns by clicking on the column indicators. When 

you do that, Maxsurf also displays the Section that is closest to the active 

column. This enables you to model on one column and its nearest section at a 

time.  

ü Click on Column indicator #1 in the Control box in body plan 

view.  
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What you are looking at now is the Transom edge on the left and the transom 

edge control points on the right. 

 
The Transom edge Control points 

ü Drag the control points on the aft most edge so that it looks like 

this (do not move the corner control points): 

 

Letôs take a moment to have a closer look at the transom shape: 

ü Switch Half Off and zoom in on the centreline-transom point: 

 

Notice h ow the transom edge is tangential to the control 

point net from the corner control point to the next 

adjacent  edge control point. This is always the case for 

all edges and is very important to remember!  

This means that the following three scenarios are possible for the transom edge: 

 
 

 

ñV-shapedò ñSmoothò ñTunnel bottomò 

Letôs shape the transom so that it is smooth: 

ü Double click on the corner control point: 
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The height of the corner control point = 0.5 m 

ü Now double click on the adjacent edge control point of the 

transom and set the height to 0.5 m as well: 

 

You have now completed positioning the corner control points and modelling the 

edge shapes. 

ü Save your design as MyFirstDesign_CornersEdges.msd 

Modelling Internal Control Points 

Modelling Internal Control Points ï Concepts 

After having positioned your corner control points and shaped your edges, it is 

now time to shape the internal surface. It is at this stage important to force 

yourself not to make any more changes to any control point that is either a corner 

control point or located on an edge. If you think back about the analogy with the 

painter painting the portrait, you are now probably at the stage where you have 

positioned the object (the person) on the canvas with the right size and 

proportions and sketched the outlines or contours. From here the painter can fill 

in the rest of the portrait in any order and again each painter will have his 

personal preferences.  

 

You can chose to change the position of the internal control points using any 

random window in any random order, but from the authorôs experience a good 

efficiency can be achieved using the Windows in this order: 

1. Body Plan 

2. Plan or Profile  

3. Perspective 

 

Also donôt forget that modelling in 3D is an iterative cycle and you will cycle 

through steps 1 Ą 2 Ą 3 Ą 1... several times before achieving a reasonable 

result. 
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Modelling Internal Control Points ï Video 

 Watch a short video that shows you how the internal control points are 

positioned in Body Plan view while using the control box to switch columns. 

This video also shows how to use different view windows to track down any 

irregularities in the control point net. [Web | Disk] 

Modelling Internal Control Points ï Procedures - Smoothing 

Smooth Internal Control Points 

After fixing the corner control points and shaping the edges, it is now time to 

look at the internal control points.  

ü Show the control point net 

 

Usually after you have not shown the internal control points for a while and 

made all sorts of changes to the edges and corner control points, the internal 

control point net can be quite messy. In this case it is actually not too bad as can 

be seen in the image above. There is a command available in Maxsurf that cleans 

up messy internal control point net by distributing the internal rows and columns 

evenly between the edge rows and columns in 3D. This usually provides a good 

starting point for further refinement. 

ü Use the Smooth Interior Controls command from the Markers 

menu 

 

 

 
 

ü Save the design as MyFirstDesign.msd 

Modelling Internal Control Points ï Procedures ï Body Plan View 

Body Plan 

There are a couple of things you have to learn before we can model the internal 

surface in Body plan view. 

 

 Lesson 1: From this moment onwards you should no longer modify the 

corner or edge control points; you have already shaped these points in the 

previous stages. Note that all of the points in the aft most and forward most 

columns are either edge or corner control points so do not touch those! 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/modelling-internal-control-points#sZ6JJsRfKn1YeoJ1FPY_9Q
TrainingVideos/StartingADesign4P.avi
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Lesson 2: Because the edge control points are fixed, the internal control points a, 

b and c can ï in general ï only be located in the green area unless you want a 

ñtunnel bottomò (area 2) or tumblehome (area 1). Having said that, as you get 

more experienced you will see that areas 1 and 2 sometimes have to be used to 

create specific shapes, but for now it is recommended to only use the green area 

in the middle. 

 

Internal control points should never  be positioned in 

areas 3 and 4.   

Lesson 3: Moving internal control points does not influence the shape of the 

edge of the surface. 

 

Tips:  

o In general: Always try to minimise the amount of data (Contour lines, 

Markers, Control points etc.) displayed on your screen. 

o When you are working in body plan view it is easiest to work at one 

column at a time. It is important however to realise that the 3D shape of the 

vessel results from all columns and rows being fair in 3D. This means that 

even though a section might look fair in 2D Body Plan view, this does not 

necessarily mean it is fair in 3D. When working in a 2D window, always try 

to think about the 3D shape surrounding the area of the 2D section you are 

working on. 
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o In a 2D window the movement of a control point is strictly restricted to 

movement in the plane of the window. For example: in Body Plan you can 

only move control points in the Y-Z plane and movements in the X direction 

(Fwd or Aft) is not possible. Movements in the X direction should instead be 

done in either the Plan or Profile view. Moving control points in Perspective 

view is also possible, but a little more complicated and will be discussed 

further on in the training manual.  

 

ü Hide the Net 

ü Switching between the columns using the control box, position the 

control points of each column to shape the internal surface.  

There is no particular order you should do this in, but in this tutorial 

ü Start with the 2
nd

 column from aft and work your way towards the 

bow 

ü You can use your own creativity for the position of the internal 

control points, or use the suggested locations in the table below: 

Internal 

Control point  

Suggested location 

 a Directly below deck edge for vertical walled 

hull/deck 

 b Drag outwards for more voluminous hull 

 c Same height as centreline edge control point for 

smooth transition across centreline 

ü  

 

 

 
 

ü Switch to Plan view to check your adjustments 

Modelling Internal Control Points ï Procedures ï Plan or Profile View 

Plan view or Profile view 

After you have roughly positioned the control points in Body Plan view, check 

the position of the control points in Plan and Profile view. 

Show the Net 

Before you made changes in Body Plan it looked like this: 
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It may now look more like this:  

 

Boats usually donôt get built with zigzags in the hullshape, so try to avoid these 

zigzags in the control point net as well: 

 

Instead of zigzags, try looking for ñbananasò: smooth curves.  

Do the same in Profile view 

 

 

Continue to make adjustments where necessary. Your aim should be to make all 

control points rows and columns ñflowò in smooth lines, remembering that a 

smooth control point net results in a smooth surface. 

 

Shaping the internal surface is a highly iterative process. Switching between 

columns in Body Plan view and switching to the other view windows often, will 

slowly make the design fairer. This fairing takes some experience and will be 

discussed later in the training material. 

Modelling Internal Control Points ï Procedures ï Perspective View 

Perspective view 

By rotating the model whilst showing the Net, all irregularities in the control 

point net become visible. 

 

Making adjustments to the control points net in Perspective view is not 

recommended for inexperienced users.  

 

The perspective window can also be used to find and select a control point that is 

difficult to select in one of the 2D view windows because it is hidden by other 

control points. In Perspective view you can rotate the model and find and select 

the control point you need. A selected control point in any view window in 

Maxsurf will also be selected in the other windows. For example:  
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In case you want to select this control point in Profile view..  

 

But in Perspective view it is easy to find it and select it é 

 

And in Profile view the control point is selected as well.  

ü Show the Net 

ü Check the control point net in the Perspective window by rotating 

the model 

  

A minor zigzag can be seen in perspective view at particular orientation angles. 

Generally you will want to investigate this and fix it in the 2D view windows. 

You will learn more about this in the basic fairing section of this training 

manual.  

 

Donôt spend too much time on the internal control points at this stage. When you 

are done with the model you can lock the surface from Surfaces | Locking: 
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ü Go Surfaces | Locking and place a tick next to the Hull surface.  

You can also use Right click on the surface in the Assembly Pane, or use the 

Surface Properties dialog to lock the surface. Locking the surface will lock and 

hide all control points, preventing any unintended changes. 

ü Save your design as MyFirstDesign.msd 

 

Congratulations! You have created your first design by starting a new design and 

inserting and modifying a surface from the Maxsurf surface library. The next 

section in this training manual will take you through an alternative option to 

starting a design: Modifying an Existing Design. 

Modifying an Existing Design 

Previously you have learnt how to model a design from scratch by inserting a 

pre-defined surface from Maxsurfôs surfaces list and then modifying it. 

 

As mentioned earlier in this training manual, there are different options to start a 

new design and you can ï as an alternative to starting completely from scratch ï 

start a new design by changing an existing design from the Maxsurf Sample 

Designs library. With an extensive collection of designs from small yachts to 

container ships, you are likely to find an existing design that you can modify to 

produce the design you have in mind. 

 

Letôs first have a look at a few of the sample designs that get installed with 

Maxsurf before we continue and look at some tools to make modifications to an 

existing design. 

 

Start with the section on Exploring Sample Designs Directory. 

Exploring Sample Designs Directory 

ü In windows explorer, navigate to c:\program files\Maxsurf  ##, 

where ## is the version number. 

Depending on which Maxsurf applications you have installed, you will see 

something like this: 
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The following items in this folder are worth mentioning at this stage: 

1. Automation Samples are for the advanced users only and contain for 

example sample spreadsheets with Macros that drive Maxsurf or other 

applications of the Maxsurf suite from the spreadsheet. 

2. Reference Designs are designs that have been used to benchmark some 

of our analysis software like Seakeeper. 

3. Sample Designs contains a library of different samples. We will have a 

closer look at this folder below.  

4. Sample Modelling Features folder contains parts of a ship that have been 

modelled a specific way; for example a propeller or the stern of a ship. 

5. Training Samples folder contains all samples that are used in training 

documents. 

6. A long list of files containing the manuals, applications, libraries, 

supporting DLLs etc. Donôt ever change anything to this list unless you 

know what you are doing! 

ü Open the Sample Designs Directory 

Depending on which Maxsurf applications you have installed youôll see 

something like this: 
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1. All samples in the Sample Designs directory have been sorted by ship 

type.  

2. This list consists of several sample designs; one for each application of 

the Maxsurf suite. 

 

Some examples: 

 

Catamaran Ferry  

Shows a complex surface topology 

specific to catamarans. 

 

Wave piercing catamaran 

Another example of complex surface 

topology for a catamaran. This 

wavepiercer has an integrated 

superstructure. 

 

Patrol vessel 

The hull of this model shows a good 

distribution of control points and is faired 

very nicely. The decks and keel trim the 

hull. 

 

Motor yacht 

This model features numerous bonded as 

well as trimmed surfaces. There is a video 

on the website that shows the different 

techniques used to model this vessel. This 

video is only available to users of Maxsurf 

with current subscription. 
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Fast yacht 

This model uses numerous trimming 

surfaces and consists of NACA keel (incl. 

bulb) and rudder and has a cockpit and 

coach roof. Good starting point for any 

sailing yacht. 

 

Container ship 

This model shows a surface topology that 

can be used for large ships such as 

containerships with flat of sides, bowcone, 

stern bulb and bulbous bow. Uses a 

trimmed deck / sheer line. 

 

Anchor handling vessel 

This simple looking hull can be used as a 

starting point for many workboats such as 

OSVs, tugs etc. The model features many 

bonded surfaces allowing each surface to 

be developed separately to minimise plate 

forming production cost. 

 

Workboat 

There are several workboats in the sample 

design library; each one with different 

number of surfaces and features. This one 

uses bonded surfaces and consists of a 

bowcone, topsides, bottom and chine. 

Good starting point for crew boats but also 

some open deck fishing vessels. 

 

Now it is time to learn how to make Simple modifications. 

Simple modifications 

Simple modifications ï Concepts 

Letôs face it: most ships all look the same. This means that in most cases it is 

possible to take an existing design and, for example by simply resizing it, get 

reasonably close to a customerôs requirements. In Maxsurf, resizing and/or a 

simple parametric transformation (eg increasing the displacement) can all be 

done without touching control points. This means that if you for example have a 

fair design that was built 30 m long with a displacement of 44 tonnes you can 

have a 35 m ship with a displacement of for example 54 tonnes in a matter of 

minutes. And even better: the fairness quality of the surface model will be 

maintained during the modification. 

Simple Modifications ï Video 

 Watch a short video that shows you how to resize the trawler sample design 

and apply a simple parametric transformation on your own MyFirstDesign file: 

increasing the displacement whilst keeping the draft the same. [Web | Disk] 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/modifying-an-existing-design#CwkHNCXkYz-tlAeFa5OvxA
TrainingVideos/SimpleModificationsP.avi
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Simple Modifications ï Procedures - Resizing 

Resizing 

To modify an existing design, you will first need to unlock the relevant 

surface(s) that you wish to make modifications to. We will return to the sample 

trawler model as it is a simple single-surface model.  

ü Close any currently open design by going to File | Close Design.  

ü Select Open from the File menu. 

ü Navigate to the Maxsurf program file directory (C:\Program 

Files\Maxsurf \Sample Designs 

ü Open the design called Maxsurf Sample_Trawler.msd. 

ü Display the Sections and the Grid 

To modify the design in any way, the applicable surface(s) have to be unlocked. 

If a surface is locked, its control points cannot be moved and are hidden. 

ü Go to Surfaces | Locking  

 

ü Remove the tick next to the Hull surface by clicking it with the left 

mouse button. 

 

Note: you can also resize the surfaces using right clicking in the Assembly Pane. 

 

Suppose we wish to resize the trawler from an overall length of approximately 

45 m down to 25 m.  

ü Go to Surfaces | Size Surfaces 
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When resizing a surface, it is necessary to decide which, if any, of the 

dimensions should be scaled proportionately. Use this proportional scaling if you 

have a basis design of which you wish to maintain the beam:depth ratio, 

length:depth ratio and/or length:beam ratio. To scale two or more dimensions 

proportionately, place a tick next to the items that should remain in proportion. 

For example, to maintain length:beam ratio, place a tick in the proportional 

scaling boxes of length and beam; if you would like to keep all dimensions in 

proportion, place a tick in all three boxes. 

ü Place a tick in all three proportional scaling boxes. 

ü Enter 25m for Length. 

Observe how the beam and depth values automatically update to maintain the 

L/B and L/D ratio. 

ü Click OK. 

Simple Modifications ï Procedures ï Parametric Transformations 

Parametric Transformations  

Please read the Using Parametric Transformations topic from the Manual (it is 

only necessary to read up to the Parametric Transformations Restrictions 

heading. Example exercises do not need to be performed).  

ü Open your own MyFirstDesign.msd file.  

Alternatively, you can open a copy of the file from the C:\Program 

Files\Maxsurf\Training Samples directory. 

ü Save the design as MyFirstDesign_transformed.msd 

It is generally good practice to save to another filename before doing a 

parametric transformation or working with the standard sample designs. 

ü  Go to Data | Parametric transformation 
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ü Tick the Displacement and Draft boxes 

ü Change the displacement to 110% of the current value. Leave all 

other values as they are. 

This will search for an increased displacement by varying the Lwl and Beam, but 

keeping the Draft the same. If you used the supplied MyFirstDesign.msd from 

the C:\Program Files\Maxsurf\Training Samples directory, the Scale To box 

should appear as follows: 

 

ü Press Search and wait for the hourglass to disappear 

Note that the waterline length and beam have both increased and that the 

increase in length is reflected in the profile view of the model in the 

dialog. 

 

ü Press OK to accept the new hullshape 

Note:  

óImmersed depthô is equivalent to the draft in the parametric 

transformation dialog; óLwlô denotes waterline length and óBeam 

wlô the waterline beam (the maximum width of the waterplane). 
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ü Go to profile view and do a Ctrl+Z to undo the parametric 

transformation and a Ctrl+Y to redo it. This quickly gives you an 

idea of the changes. 

ü Resave the transformed model. 

 

Continue with the section Other Options to Start a New Design. 

Other Options to Start a New Design 

Previously you have learnt that you can start a project by starting from 

scratch or by using an existing design and modify this to match design 

requirements. Generally, the naval architect is confronted with a variety of 

projects with different combinations of input data and output requirements. For 

example: a customer only provides paper drawings of a ship and needs to have 

the stability booklet re-issued after a modification to one of the tanks. This 

means that a Maxsurf model has to be created so that this can be used in 

Hydromax for Hydrostatic analysis. Another example may be that the customer 

has a DXF CAD drawing and wants to build a similar ship with minor 

modifications to the sheerline. In this case a Maxsurf model has to be setup in 

such a way that the surface model is useful in Workshop to expand plates, define 

stiffeners and frames and other primary construction parts. Both examples above 

have different input data and require very different surface models to deliver 

output that satisfies quality standards. Deciding the most cost effective way to 

handle the examples above requires a fair amount of experience and is thus not 

within the scope of this training manual. Extensive documentation on this topic 

is available to users with current subscription. 

 

Continue with the next section where you will learn some Chapter 6 Basic 

fairing techniques and concepts.



 81 

Chapter 6 Basic fairing 

In this tutorial you will learn some background information on surface fairing 

and how several display and fairing tools in Maxsurf can be used to help you 

obtain a fair design. 

 

Start by reading the section on the Fairing Concept. 

Fairing Concept 

To really understand the concept of fairing surfaces it may be helpful to look 

at how lines fairing was done historically. The draftsman would use a rod (or: 

batten), bend it and place weights on it to fix its shape. The more curvature was 

needed, the more weights were needed to hold the rod in position or a more 

flexible rod had to be chosen. Adding more weights on top of the rod, would also 

make it easier for unfairness (i.e. inflexions in the curve) to arise. To prevent 

that, the draftsman would lift each weight up, let the rod ñrelaxò and put the 

weight down again. With this procedure, he would iterate to obtain the required 

shape. Instead of adding more weight to areas of high curvature, the draftsman 

could also choose to use a rod with less stiffness. The disadvantage of that is that 

the flexible rod would make it very difficult to fair parts of the curve with less 

curvature. Ultimately, the experienced draftsman would look for the stiffest rod 

and use as few weights as possible to obtain the required shape.  

 
 

In Maxsurf, a B-spline surface can be seen as the rod and the control points as 

the weights. (See Chapter 2 of the Maxsurf manual on the Basic Principles). 

 

Start learning fairing in Maxsurf in the section on Displaying Curvature. 

Displaying Curvature 

Maxsurf has a range of tools to display curvature on curves or contours (eg a 

buttock) as well as on surfaces. 

 

In this section of the training manual you will learn the different display tools 

and also get a feel what makes a line/surface fair or unfair by manually removing 

control points from a curve or adjusting their position. In the next section you 

will then learn different tools and techniques that Maxsurf offers to assist you 

improve fairness. 

 

Start with the section on Display Curvature on a Curve or Contour. 
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Display Curvature on a Curve or Contour 

Display Curvature ï Concepts 

In this section we will look at some tools to display the curvature on curves and 

surfaces. We will go through a number of steps displaying the curvature on a 

curve and making simple modifications to the curve to improve the fairness. 

ü In Maxsurf, go to the Profile view window 

ü Open the BasicFairingSpline_Start.msd file  

 

You will see something like this: 

 

You can see that the left side of the curve only contains a few control points, 

while the right side has the control points much more densely spaced. A lot of 

the control points on the right can be removed without changing the shape of the 

curve while improving the fairness of the curve. But how do you actually judge 

the fairness of this curve? This is where you need some display tools like 

Curvature porcupines and compress.  

Display Curvature ï Video 

 View a video that will show you the different curvature display tools for 

curves such as Curvature porcupines and Compress view. The video will also 

show some steps to manually improve the fairness of this curve. [Web | Disk] 

Display Curvature ï Procedures - Properties 

Curvature  Porcupines 

The curvature on contours may be displayed in the form of porcupines. 

ü Select the spline curve 

 

ü Now select Show Curvature from the Display | Curvature menu or 

using the toolbar button below: 

 

You will see something like this: 

 

ü Read about curvature porcupines in the Maxsurf manual. 

 Note: The value of the smallest radius (tightest bend) on a given curve is 

displayed numerically at the end of the porcupine located at the corresponding 

position on the curve. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/displaying-curvature-on-a-curve#0126D1r-Ll0MDvNFJ8c_CQ
TrainingVideos/DisplayAndImproveFairnessOnCurveP.avi
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You can also see that the curvature porcupines change sides from the upper to 

the lower side of the curve. This means that the curvature direction changes from 

positive to negative or visa versa. Changing of the curvature direction may be 

classified as an inflection. There are a number of inflections in this curve: 

 
Inflection 1 may be classified as unfairness, whilst inflection 2 may be a feature 

of this curve. 

ü Increase the longitudinal stiffness of the curve from 3 to 4 using 

the Surface Properties dialog from the Surfaces menu. 

By increasing  the stiffness the curvature discont inuity  is 

reduced . 

ü Remove one control point from the inflection area 

 

 

ü Space the control points in the area so that they are evenly 

distributed by moving the middle control point as shown below. 

 

ü Adjust  the height of the middle control point to remove the 

inflection and produce a continuous curvature along the curve in 

this area. 

You should now see something like this: 
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The surface fairness can be improved b y increasing the 

surface stiffness, removing control points and spacing 

the control points evenly . 

 

ü Now continue removing control points nr 4, 6, 8 and 9 

 

This again leads to a dramatic improvement of the fairness. See 

BasicFairingSpline_EndCurvature.msd file. 

You should use the stiffest spline and minimum number 

of control points that will give the  desired shape.  

 

Now letôs use the compress curvature display tool to further improve the fairness 

of this curve. 

Display Curvature ï Procedures - Compress 

Compress 

This expands the transverse and vertical axes in relation to the longitudinal axis 

in the plan and profile views. This can be helpful when fairing long, slender 

hulls. 

ü In  Maxsurf Profile window, open 

BasicFairingSpline_EndCurvature.msd  

ü Select Compress from the Display menu 

 

We can now see that the fairness can be further improved by distributing the 

amount of curvature along the length of the curve better so that we end up with 

something like this:  
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Exercise: Try fairing the curve by using the compressed view to produce a 

curvature distribution similar to the one above. 

 

A few pointers: 

ü Whatever you do, donôt touch the corner control points (1 and 9)! 

ü Distribute  the control points evenly long the curve, with a steadily 

reduced space between the control points on the right side of the 

curve 

ü Move the control points up and down in small increments 

Tip: you can use the arrow keys of your keyboard to move a control point up and 

down 1 mm at a time. 

 

 

Continue with the Display the Curvature on a Surface section. 

Display the Curvature on a Surface 

Surface Rendering ï Concepts 

You can colour shade or render a surface to display the shape and curvature. 

Maxsurf has different rendering types available. Each rendering type can be used 

for different purposes. 

 

See the Maxsurf manual section on Rendering a surface for more information on 

the different rending options. 

 

We will explore the following surface rendering options: 

 Simple Shading  

 Smooth Shading  

 Longitudinal curvature  

 Transverse curvature  

 

The other rendering options you will see in the Rendering dialog are not useful 

to display the fairness of the surface and will not be discussed in the Learning 

Maxsurf training manual.  

Surface Rendering ï Video 

 View a video that will show you the different rendering options in Maxsurf. 

[Web | Disk] 

Surface Rendering ï Procedures 

Surfaces can only be rendered in the Perspective window. 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/displaying-curvature-on-a-surface-using-rendering#6ZpVCK5BROt75_twNW256Q
TrainingVideos/SurfaceRenderingP.avi
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ü In Maxsurf, switch to the Perspective View window 

ü Open the BasicFairing_SurfaceRender.msd file 

Depending on which contours you have displayed, you should see something 

like this:  

 

ü Select Display | Render and select the Simple Shading option from 

the Rendering Selection dialog: 

 

You should now see something like this:  

 
Simple shading 

Note that even though it provides you with good information about the 3D shape, 

this is not very useful to evaluate the curvature or fairness of the design. Letôs try 

the next rendering option. 

ü Switch to Smooth Shading in the Rendering Selection dialog 

You will now see something like this: 
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Smooth shading, black surface colour 

This is a lot more useful display to visualise the curvature. Use the slider bars 

and/or free rotate buttons of the Perspective window to rotate the model and look 

closely at the light reflecting off this surface. This gives you immediate feedback 

if there are any lumps or inflections. We can do better though: 

ü From the Surfaces | Surface Properties, change the colour of the 

surface to gold by double clicking in the ñappearanceò square which 

brings up the colour picker dialog. 

 
Now the surface looks something like this: 

 
Smooth shading, gold surface colour 

This is again a lot more useful to visualise any unfairness. The gold colour of the 

surface reflects a lot more light than the black colour. 
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Some colours are better than others to visualise surface 

curvature.  

ü In rendered mode, you can switch lights on/off. Experiment with 

switching lights on/off. Ignore the button with the hand icon on the 

far right.  

ü Finally, set them as in the image below: 

 

ü Again rotate the model in Perspective view so that you get 

something like this: 

 

By rotating the model and switching lights on/off we have visualised an areas 

with discontinuous curvature. Letôs have a look at the actual curvature of the 

surface in this area now: 

ü In the Rendering Selection dialog, select Longitudinal Curvature 

 
Longitudinal curvature rendering 

As you may have read in the Maxsurf manual, the green areas have zero 

curvature (read: run along a straight line in longitudinal direction) and ï if the 

surface normal has been setup correctly ï the blue areas are positive curvature 

(convex) and the red areas are negative (concave).  

 

What you are looking for are the transitions between for example green and blue 

or red. Where the colour changes rapidly, there is a rapid change in curvature 

which usually means unfairness. Changes from blue into red without any green 

in between are generally undesirable. 
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Rapid transition from Green into Blue A more blurry transition between  
Blue and Green 

 

Finally letôs have a look at the transverse curvature: 

ü Switch to Transverse Curvature in the Rendering Selection dialog 

 

Transverse curvature rendering 

Notice that this does not show the same areas of green, blue and red. This is 

because we are now looking ONLY at the curvature in the longitudinal direction. 

What is clearly visible with this rendering on this model is the transition from the 

flat of sides to the bilge radius. It is debatable whether ï in this case ï this is 

unfairness or a feature of the design. 

Exercise:  

ü Switch rendering off by clicking on this toolbar button: 

 

ü Switch all contours off except for Edges and Sections 

ü Select one of the sections in the midship 

ü Select Display | Curvature | Show Curvature 

This looks a bit messy! Letôs scale down the curvature porcupines 

ü Select Edit  | Preferences and set the Curvature Porcupine size to 

5%:  
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You should now see something like this: 

 

Using a combination of rendering s and curvature 

porcupines you  can get a good understanding of the 

curvature of the surface.  

 

This completes the section on displaying fairness on a curve or surface. Now 

letôs have a look at some basic fairing  tools in Maxsurf that help you adjust the 

fairness of a design. 

 

Next: Basic Fairing Tools & Techniques. 

Basic Fairing Tools & Techniques 

In this section we will use different fairing display techniques from the previous 

section and learn how to use simple fairing tools to make improvements to a 

curve (eg an edge of surface) and surfaces or parts of a surface. 
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Continue with Straightening Control Points.  

Straightening Control Points 

Straightening Control Points ï Concepts 

Maxsurf has a straightening tool that will straighten: 

1. all control points on a row or column between two selected control 

points on the same row or column: 

   

  

2. all control points on a surface patch defined by two diagonally 

opposite selected control points: 

 

 

 
 

This straightening can be done either: 

1. From the current view direction. You will only see the control points 

on a straight line from the current view direction, but they will not be 

straightened from the other view directions. 

2. In 3D. The control points will be straightened in 3D; regardless what 

view direction you are looking from. 

 

In the procedures below you will learn how this command can be used for 

specific purposes as well as its side effects. 

Straightening Control Points ï Video 

 View a video that shows you how to use the straighten command to 

straighten control points on the deck edge of a containership followed by 

straightening the Flat of Sides area of the hull. [Web | Disk] 

Straightening Control Points ï Procedures ï Row or Column 

Straightening a row or column 

ü Open the BasicFairing_FairingToolsStart.msd in profile view 

ü Hide the Control point net 

ü Switch the Compress display on 

You should now see something like this: 

http://www.formsys.com/support/learning-centre/training/maxsurf-introductory2/introductory-videos/straightening-control-points#atgBIaZxPM4xNzbh2Ggh6Q
TrainingVideos/StraighteningControlPointsP.avi
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Notice how the compress display suddenly shows that the top edge of the surface 

is not a straight line whereas in normal view this was difficult to see.  

 

Letôs straighten this top edge: 

ü Select the aft corner control point 

ü While holding the Ctrl or Shift key down, select the top edge 

control point located at 68.5 m fwd of Aft Perpendicular (column 9) 

ü Use the Controls | Straighten Controls | In Current Plane only 

command. 

 

This results in a movement of the control points that lie between the two 

selected control points (A and B) in the direction perpendicular to a straight line 

connecting A and B onto that straight line. This straight line can be straight in 3 

dimensions or a straight line from the current view direction only.  

 

To straighten just one row or column, A and B have to be on the same row or 

column respectively. 

ü Now switch to Plan view 

ü Notice how this deck edge is  not straight in this view direction 

We can fix this by repeating the command above for this view direction, or using 

a straighten command in 3D. 

ü Undo the straighten command by using Ctrl+Z or reloading the 

design from the start of this section. 

ü In plan view, select the Aft corner control point (A) and the edge 

control point at 68.5 m fwd of Aft Perpendicular (column 9) (B) 

again.  
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ü Use Controls | Straighten | In Three Dimensions 

Notice how this has straightened all controls points between A and B in both 

Plan view as well as in Profile view. When you use Straighten in Three 

Dimensions, it does not matter which view window you are in as opposed to 

when using Straighten in Current Plane which only straightens in one direction. 

Straightening Control Points ï Procedures ï Surface Patch 

Straightening a Surface Patch 

The previous section you learnt how to straighten a row or column of control 

points 

ü Continue with the model from the previous section, or open the 

BasicFairing_FairingToolsBowStraight.msd 

ü Switch to Perspective view 

ü Use the Transverse Curvature rendering 

ü Rotate the model so that you see something like in the image on 

the left: 

 

 

 
 

You can see that there is a transition from red into blue without any green in 

between at about midship. This should be the flat of sides (FOS) and thus 

coloured green (green = no curvature = flat). We can use a straighten command 

to straighten this panel. First letôs see how the straighten command works on 

panels, by making a ñmistakeò. 

ü Switch rendering off and zoom in to the bow area 

ü Switch the net on 

ü Select the bow corner control point and a control point in the 

middle of the bow area like below: 
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ü Use the straighten in three dimensions command 

Youôll see something like this:  

 

This model can be viewed by opening BasicFairing_FairingToolsBowStraightEnd.msd 

 

In the background, Maxsurf has done the following steps: 

Step 1:  

The area that the straighten command is applied on is determined from the 

selected control points. This can be called a patch of control points: 

 

Step 2:  

All four corner points of this patch are fixed in space and will not move. Patches 

selected by selecting two points on the Net are always four-sided and have four 

corner control points. 

Step 3:  

The edge control points are straightened between the corner points* 

Step 4: 

The internal control points are straightened between the edge points* 
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*same as for straightening a row or column, this can be done either in three 

dimensions or in the current plane only. The current plane in Perspective view is 

determined by the orientation of the model. In the bottom right hand corner of 

the Perspective window, there is a little orientation icon that indicates the current 

working plane. It is important to rotate the model in such a way that you have the 

correct current working plane when using the ñStraighten in Current Plane Onlyò 

command as it will affect in which direction the control points are straightened. 

 
The orientation icon indicates that the current 

working plane is Body Plan view. 

 
The orientation icon indicates that the current 

working plane is Profile view. 

 

Now letôs use what we have learnt so far to straighten the flat of sides panel: 

ü Undo the last straighten command so that you get your regular 

bow shape back or load the 

BasicFairing_FairingToolsFOSStraight.msd file. 

First we have to determine which control points we have to select in order to get 

a straight patch. 

ü Switch transverse curvature rendering on and zoom in so that you 

can see the stern and midship. 

 

Remembering what Maxsurf does in the background when straightening a patch 

of control points in step 2 (fixing the corner control points), it is important to 

know the location of the corner control points before using the straighten 

command: 

ü Double click on all corner points of the patch as in the image 

above: A, AB, B and BA. Notice that they are all offset from the 

centreline by 9 m. This means that all four corner points are planar 

which is what we want for this flat of sides panel. 
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ü Switch rendering off in order to select the patch corner points A 

and B 

ü Apply the Straighten in Three Dimensions: 

 

We clearly see the flat of sides appearing after applying a straighten command 

Notice how the shape of the control point net that forms the bilge-FOS line (from 

AB to B) has now become a straight line. This is not what we want.  

ü Undo the straighten command 

ü Rotate the model similar to the image below and switch rendering 

off 

ü Selecting the same patch as before, now use a Straighten In 

Current Plane Only command: 

 

This model can be viewed by opening BasicFairing_FairingToolsFOSStraightEnd.msd 

You can see how the Straighten in current plane command maintains the shape 

of the Bilge ï FOS line. This is because, when you rotated the model to the 

orientation as in the image, the current working plane was set to Body Plan.  

ü Read the text directly below step 4 (above) again 

ü Undo the change you just made 

ü Rotate the model around the ñYawò axis so that the orientation 

icon indicates that Profile view is the current working plane: 




















































































































































